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Proprietary Notices 
 
 
 
 
 
 
Xtend is a proprietary product of Yoda Software 
    Yoda Software PTY LTD 
    PO Box 496 
    Leederville, Western Australia 6903 
 
 
 
Model 204TM and Connect* are proprietary products of  Computer Corporation of America.  
204TM is a registered trademark of Computer Corporation of America. 
 
    Computer Corporation of America 
    500 Old Connecticut Path 
    Framingham, Massachusetts 01701 
    USA 
 
 
 
Janus Web, SiriusMods and Sirius Functions are proprietary products of Sirius Software, 
Inc 
    Sirius Software, Inc. 
    875 Massachusetts Avenue, Suite 21 
    Cambridge, Massachusetts 02139 
    USA 
 
 
 
Windows�

 
is a registered trademark of Microsoft Corporation 
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Introduction 
 
 
 
Overview 
 
Xtend is a GUI based editor designed specifically to edit procedures written in Model204 
User Language. By leveraging the power of the Windows� environment using colour and 
visual cues, Xtend allows for faster and more accurate development of Model204 procedure 
code. 
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Introduction 
 

 
 

Key Features 
 

� Xtend has a Windows� based look and feel allowing for a shorter learning curve. 

� Xtend is Model204 aware, which provides excellent real time visual cues for new 
and experienced programmers alike. 

� Xtend offers maximum flexibility to the programmer to tailor the product to suit 
their individual/company needs. 

� Xtend allows for code to be developed independently from mainframe availability. 

- Less interaction with the mainframe means a decrease in CPU. 

- Programmers are less affected by mainframe down time. 

- Programmers are 'quarantined' from slow mainframe response times. 

- Allows programmers to work with locally saved procedures. 

 

 

 

Minimum Requirements 
 
Mainframe 
 - TCP/IP connectivity between mainframe and PC 
 - Model204 V4R2.1 
Connect* 
 - Connect* decryption key 
 - Model204 V5R1.0  this version comes with 2 Connect* RCL threads 
Janus Web 
 - Janus Web 
 - Sirius Mods 6.1 
 
PC or Laptop 
- Windows 98/NT4+/2000/XP 
- Connect* v5r1 (if connecting via Connect*) 
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Procedure List 
 

 
 
 

Connection Types 
 
There are two modes of connecting to Model204.  One or both can be used simultaneously 
by Xtend to send and receive data from multiple Remote Hosts. 
 

� Connect*  
� Janus Web 

 
 
 
Procedure List Interface 
 

 
 
 

� Multiple views for Development/Test and Production 
A workspace can be set up with any number of remote views.  A remote view is 
essentially the same as running another instance of a 3270 emulator application. 

 
� Views saved automatically on application exit 

Each remote view is saved on exit, unlike most current 3270 based editor set-ups 
where only the last view is saved. 
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Procedure List 
 
 
 
Remote Setup 
 

 
 
The Remote TAB on the Options screen is used to add Remote Host entries into Xtend.  
These are used by Xtend to send and receive data from Model204. 
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Editor Interface 
 
 
 
Moving around the editor interface 
 
Moving around the editing interface can be done in a number of ways: 

� Page Up/Down keys 
� Arrow keys 
� Scroll Bar 
� Home and End keys 
� Standard Windows� keystroke combinations  (eg:CTRL + HOME) 
� F7 and F8 to move through a Model204 'block' 

 
 

 
 

 
 
None of these involves any interaction with the Remote Host.  The only equivalent 
<ENTER> keys are for the initial Edit and when a Save is processed.  This allows the 
programmer to be effectively quarantined from a slow development machine. 
 



Yoda Software   Page 9 

 
 

Editor Interface 
 
 

Colouring text 
 

 
 
The Colour Options screen allows individual tailoring of the editing interface, making for 
more readable and thus easier to understand Model204 User Language code 
 
 
Procedure Code Display Options 
 

 



Yoda Software   Page 10 

 
 

Editor Interface 
 

 
 
Tool tips 
 
These features can save an enormous amount of time (and frustration) when writing User 
Language code.  Each $function is also detailed in the Xtend Help file and is accessed 
simply by placing the cursor on the $function and pressing the F1 key. 
 
Mouse Over 

                        
 floating position   status line position 
 
$Function parameters 

 
 floating position 

 
       status line position 
Subroutine parameters 

 
 
Variable Drop-down box 

 
 
$Function Drop-down box 

 

Image/Screen Drop-down box 
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Editor Interface 
 

 
 

Tool tip Display Options 
 

 
 
Display Image and Screen Drop Down Boxes 
This option provides selection of image or screen items from a drop down box when the “:” 
key is pressed on a valid image or screen name. Pressing the TAB key will select the 
highlighted item 
 
Display Subroutine Parameters  
This option provides a pop-up dialog showing the parameters of a complex subroutine 
 
Display $Function Parameters 
This option provides a display showing the syntax of a Model204 $Function. The display 
can be in a pop-up dialog or in the status bar 
 
Display Variable Declarations (on mouse over) 
This option provides a display showing the variable declaration. The display can be in a 
pop-up dialog or in the status bar 
 
Display Variable/Image/Screen List 
This option provides selection of defined variables, images or screens from a drop down 
box when the “%” key is pressed. Pressing the TAB key will select the highlighted item. 
The drop down box appears after the delay specified in seconds if no other key is pressed. 
 
Display $Functions List 
This option provides selection of $Functions from a drop down box when the “$” key is 
pressed. Pressing the TAB key will select the highlighted item. The drop down box appears 
after the delay specified in seconds if no other key is pressed. 
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Editor Interface 
 

 
 

Features 
 

Find & Replace 
Activated by CTRL+F, this is similar to 
the   Find & Replace found in word 
processors (eg Microsoft� Word).  
 
Fast Find 
By placing the cursor on a word and 
pressing CTRL+F3, the cursor will jump 
to the next occurrence of that word. 
Pressing CTRL+SHIFT+F3 will show the 
previous occurrence. 
 
Cut/Copy & Paste 
Highlighted text can be cut, copied and 
pasted using the standard Windows� 
CTRL+C, CTRL+X, CTRL+V.  CTRL+C 
when no text is highlighted, will copy the 
line the cursor is on. 
 
Upper/Lower case conversion 
Highlighted text can be converted to 
upper/lower case using CTRL+U or 
CTRL+L.  When no text is highlighted, 
the current line is converted. 
 
Non-consecutive line copying 
To copy non-consecutive lines, select the 
line by clicking the line numbers to the left 
of the code and then use CTRL+C, 
CTRL+X or the toolbar buttons or menu 
options. 
 
Automatic Line indentation 
When ENTER is pressed, the cursor is 
automatically indented to line up with the 
text on the previous line. This option is set 
in the procedure code display options. 

Tabbing (single/multiple line) 
When the TAB key is pressed the cursor 
will move a set number of spaces to the 
right.  (SHIFT + TAB moves to the left). 
The same action can be performed on 
highlighted text which also allows the use 
of the left and right arrow keys to move 
the text 1 space. The set number of spaces 
can be set in the procedure code display 
options. 
 
Comment/uncomment multiple lines in 
a single action 
To comment out multiple lines of text, 
simply highlight the text required and 
press CTRL+8. Using CTRL+SHIFT+8 
will uncomment the lines. 
 
Auto lowercase comment lines 
To automatically lower case comment 
lines, set the ‘Auto lowercase comment 
lines’ option in the procedure code display 
options. 
 
Auto uppercase non-comment lines 
To automatically uppercase non-comment 
lines, set the ‘Auto uppercase non 
comment lines’ option in the procedure 
code display options. 
 
Suppress lines 
This feature allows the suppression of 
code that does not contain a certain string 
or combination of strings. Use the toolbar 
button or menu option to activate. 
Highlighted text can also be suppressed 
using CTRL+H. 
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Editor Interface 
 
 
 
Features Continued 
 
 
Templates 
Comment blocks, subroutine definitions or 
any piece of code can be set-up as a 
template. 
 
GO! 
Procedures can be run using the GO 
button or the file Go menu option. The 
results are displayed in a separate window. 
 
Fast browse (Shift F2) 
Place the cursor over a procedure name in 
an INCLUDE statement and press 
SHIFT+F2 to display a dialog to confirm 
the online, procedure file and name (any 
of which can be changed), press enter to 
browse the procedure. 
 
Line wrap 
Lines that do not fit on the editing window 
can wrap around to the next line. Wrap 
mode is toggled on and off from the 
toolbar. 
 
Line Length 
Maximum line length can be set between 
60 to 255 and is set in the procedure code 
display options. 
 
Scroll through a Model204 block 
To ‘jump’ through Model204 blocks of 
code such as ‘IF/THEN/ELSE’ or ‘FOR’ 
blocks of code, place the cursor on the ‘IF, 
ELSE, END IF, FOR, END FOR’ and 
press F7 to move forward or F8 to move 
backwards. 
 
Undo and Redo 
Use CTRL+Z to undo the last change(s) or 
use the edit menu or toolbar buttons to re-
do the last change(s). 

 
Syntax checking 
Xtend has a simple inbuilt syntax checker.  
Select Syntax check from the Edit menu. 
 
Define/Redefine variables 
To define or redefine a variable, place the 
cursor on the variable and press 
SHIFT+F4. A dialog will appear showing 
the variable  
definition allowing it to be added or 
changed. Pressing enter adds or changes 
the variable declaration.  Press ESC to 
cancel. 
 
Jump to variable definition 
To move to a variable, image item or 
screen item definition, simply place the 
cursor on the item and press F4. To return 
to the previous position in the code, press 
F6 (bookmark). 
 
Bookmarks 
To bookmark a position in the code, place 
the cursor at the required position and 
press SHIFT+F6. Up to 5 bookmarks are 
allowed. Pressing F6 will return to the 
previous position(s). An automatic 
bookmark is created on actions such as 
CTRL+F (find & replace) and F4 (variable 
declaration). 
 
Fast Word Copy 
Press CTRL and click the right mouse 
button to copy the word under the mouse 
to the current insertion point. 
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Editor Interface 
 

 
 
Blocking Mode Features 

 
A severe limitation to a 3270 emulator is the functions available when working with a 
block of code, especially if that block is more that a page in length and/or there are 
extended lines involved. Block mode features overcome these limitations. 

 
Block mode 
To activate block mode, press CTRL+B. 
Click the left mouse button at the start 
point of the block. RELEASE the left 
mouse button. Drag the mouse to the 
required end point of the block and click 
the left mouse button again. The block 
can be drawn over one page. 
 
Cut (leaving or removing spaces) 
After the block has been defined, use the 
menu edit -> block -> cut. The leave 
spaces menu item returns blank space in 
the block. 
 
Copy 
The contents of the block are 
automatically copied into memory once 
the block has been defined. 
 
Paste (overwrite or insert) 
The block of code can be pasted in insert 
mode or overwrite mode. 
 
 

Sort 
The contents of the block is sorted 
alphabetically. 
 
Align 
The block is aligned on a word. 
 
Flip 
The text in the block is swapped either 
side of the equals sign. 

 
Fill 
This option can only be used when the 
first element in the block is a number.  
The rest of the block is then 
incremented/decremented by a number 
specified  (eg: a screen that has 20 
postcodes, type POSTCODE1, duplicate 
it 20 times, then use the block fill to 
update the screen items 2 to 20). 

 
Replace 
This will replace the contents of the 
block with a specified string.

 
Model204 Aware Formatting 
 
The Sort, Align and Flip under the menu Format option are Model204 aware functions. 
Continuation lines are taken into account with these options. The menu Format options are 
used with normal highlighted text 
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Editor Interface 
 

 
Printing Options 

 
 

 
 
Multiple Windows 
 

� Tile many windows -Xtend allows multiple windows to be tiled without 
compromising legibility. 

� Drag & drop lines of code between windows -With multiple windows opened, 
copying code between them is simple. 

� Compare procedures - Xtend has a procedure compare facility that can be used to 
highlight the differences between two procedures. It can also be used to compare 
procedure output.  (eg: PAI dumps). 

An optional banner page 
can be printed, along with 
page header details. 
 
Font size can also be 
changed for printing. 
 

Select the printer and 
printer paper size 
 
Styles for printing 

� Landscape 
� Portrait 
� Two-sided printing 
� Copies 

 
 
Highlighted text within 
the editor interface can be 
printed. 
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Other Features  
 

 
 
Procedure Compare 

 

 
 
The compare can run in 2 modes: 
 
1. Automatic 

This option will run a compare algorithm that will display the compare results. 
 

2. Manual 
This option will display the 2 procedures being compared and scroll through them until 
a difference is discovered.  At this point it will stop, show the differences and allow the 
repositioning of the compare points before continuing. 

 
 

Dump To Local 
 
The Dump to Local feature allows the ‘downloading’ of multiple procedures from the 
mainframe to the PC/Laptop allowing for offline work 
 
 

This feature allows for the 
comparison of 2 procedures 
or  output windows.  This 
option is located under the 
'File' menu. 
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Other Features  
 
 
 
Search On Local 
 
 

 
 
 
Any procedures that have been saved locally (including those via the Dump to Local 
feature) can be included in the local search facility. 
 
The search results are displayed in a NEW procedure window.  This allows easy saving or 
printing of the output. The procedure found in the search can be edited locally using the 
Fast Edit feature by placing the cursor on the remote name in the search output, and 
pressing <SHIFT> and <F2>. 
 
 
Recovery 
 
In the event of a PC crash, Xtend has a built in recovery system that will ensure that no 
more than 15 seconds of editing can be lost.  When invoking Xtend after a crash, all 
procedures that were being edited will be automatically displayed, the cursor will be placed 
back to the exact position before the crash. 
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Shortcut Keys 
 
 
 
Xtend Shortcut Keys 
 
Xtend has a number of features that can be easily accessed with a couple of key strokes.  
Some are unique to this application while others are standard Windows� functions.  In the 
list below the key strokes are represented within the angled brackets. 
 
Table1.1 
Shortcut Keys - All of the following require the CTRL key plus a shortcut Key 
 
Shortcut Key Description 

<C> copy highlighted text (if no highlighted text, then current line 
copied) 

<X> cut highlighted text 
<V> paste text previously copied/cut 
<F> invoke the Find & Replace dialog 
<S> save the procedure 
<D> delete the current line (note: the line is copied to memory and can 

be pasted elsewhere) 
<'> duplicate the current line 
<Z> undo the last processed action 
<8> add the comment character ‘*’, at the start of each line of 

highlighted text 
<SHIFT> +<8> remove the comment character ‘*’, at the start of each line of 

highlighted text (if there is one) 
<B> initiate Block Mode 
<L> converts highlighted text to lowercase (if no highlighted text, then 

current line) 
<U> converts highlighted text to uppercase (if no highlighted text, then 

current line) 
<I> use within a subroutine call or $function statement to invoke the 

ToolTip help 
<A> select all 
<E> erase to end of line 
<H> 'hide' highlighted text 
<G> run the procedure being edited.  (you will need to have sourced the 

procedure from the remote) 
<=> will 'flip' 2 strings on either side of an 'equals' sign (if no 

highlighted text, then current line) 
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Shortcut Keys  
 
 
 
< left arrow > move the cursor a word at a time to the left.   
< right arrow > move the cursor a word at a time to the right. 

Note: The $,comma, colon, equal/plus signs and brackets are 
considered as 'end of word' markers. 

< up arrow > move up to the next editor form (as listed in the 'Window' menu) 
< down arrow > move down to the next editor form (as listed in the 'Window' menu) 
<F3> find the next word equal to the one the cursor is currently over (or 

the text that is highlighted) - searching forward 
<SHIFT> + <F3> find the next word equal to the one the cursor is currently over (or 

the text that is highlighted) - searching backward. 
<F4> close current window. 
<F5> suppress all lines that do not contain the word the cursor is 

currently over. 
<right Mouse 
click> 

Move your mouse to be over the word that you want inserted, then 
press the CTRL key and click the right mouse button.  The word 
under the mouse will have been copied to where you were typing. 

 
 
Table1.2 
Shortcut Keys - Other Short Cuts (that do not require CTRL key) 
 
Shortcut Key Description 

<SHIFT> + <F2> browse the procedure that the cursor is currently over 
<F4> jump to field definition or label 
<SHIFT> + <F4> define or redefine a variable 
<F6> goto last saved Bookmark 
<SHIFT> + <F6> create Bookmark at current cursor position 
<F7> if cursor is on an m204 'block' statement, the cursor will move to 

the previous 'block' statement 
<F8> if cursor is on an m204 'block' statement, the cursor will move to 

the next 'block' statement 
<ESC> cancels Block Mode, Non-consecutive line copy mode, Suppress 

mode, closes Find/Replace screen, cancels Field Redefine. 
 
Example 
 
For example, to covert some text from UPPER to lower case: highlight the required text, 
press the CTRL key and the L key, the highlighted text is converted to lowercase.  This 
sequence of keys is represented as:  <CTRL> + <L> = converts highlighted text to 
lowercase (if no highlighted text, then current line). 


